


13–2 Chapter 13: Analyzing Designs with Quartus II Netlist Viewers
When to Use Viewers: Analyzing Design Problems
The following sections contain information about how netlist viewers display your 
design:

■ “Quartus II Design Flow with Netlist Viewers” on page 13–3

■ “RTL Viewer Overview” on page 13–4

■ “State Machine Viewer Overview” on page 13–5

■ “Technology Map Viewer Overview” on page 13–5

Using the RTL Viewer is a good way to view your initial synthesis results to 
determine whether you have created the desired logic, and that the logic and 
connections have been interpreted correctly by the software. You can use the 
RTL Viewer and State Machine Viewer to check your design visually before 
simulation or other verification processes. Catching design errors at this early stage of 
the design process can save you valuable time.

If you see unexpected behavior during verification, use the RTL Viewer to trace 
through the netlist and ensure that the connections and logic in your design are as 
expected. You can also use the State Machine Viewer to view state machine transitions 
and transition equations. Viewing the design can help you find and analyze the 
source of design problems. If your design looks correct in the RTL Viewer, you know 
to focus your analysis on later stages of the design process and investigate potential 
timing violations or issues in the verification flow itself.

You can use the Technology Map Viewer to look at the results at the end of synthesis 
and technology mapping by running the viewer after performing Analysis and 
Synthesis. If you have compiled your design through the Fitter stage, you can view 
your post-mapping netlist in the Technology Map Viewer (Post-Mapping) and your 
post-fitting netlist in the Technology Map Viewer. If you perform only Analysis and 
Synthesis, both viewers display the same post-mapping netlist.

In addition, you can use the RTL Viewer or Technology Map Viewer to locate the 
source of a particular signal, which can help you debug your design. Use the 
navigation techniques described in this chapter to search easily through the design. 
You can trace back from a point of interest to find the source of the signal and ensure 
the connections are as expected.

You can also use the Technology Map Viewer to help you locate post-synthesis nodes 
in your netlist and make assignments when optimizing your design. This 
functionality is useful, for example, when making a multicycle clock timing 
assignment between two registers in your design. Start at an I/O port and trace 
forward or backward through the design and through levels of hierarchy to find 
nodes that interest you, or locate a specific register by visually inspecting the 
schematic.

You can use the RTL Viewer, State Machine Viewer, and Technology Map Viewer in 
many other ways throughout the design, debugging, and optimization stages. 
Viewing the design netlist is a powerful way to analyze design problems. This chapter 
shows you how to use the various features of the netlist viewers to increase your 
productivity when analyzing a design.
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Quartus II Design Flow with Netlist Viewers
The first time you open one of the netlist viewers after compiling the design, a 
preprocessor stage runs automatically before the viewer opens. If you close the viewer 
and open it again later without recompiling the design, the viewer opens immediately 
without performing the preprocessing stage. Figure 13–1 shows how the netlist 
viewers fit into the basic Quartus II design flow.

To use a viewer, and before the viewer can run the preprocessor and open the design, 
compile your design with the following minimum compilation:

■ To open the RTL Viewer or State Machine Viewer, first perform Analysis and 
Elaboration.

■ To open the Technology Map Viewer or the Technology Map Viewer 
(Post-Mapping), first perform Analysis and Synthesis.

1 If you open one of the viewers without first compiling the design with the appropriate 
minimum compilation stage, the viewer does not appear. Instead, the Quartus II 
software issues an error message instructing you to run the necessary compilation 
stage and restart the viewer.

Both viewers display the results of the last successful compilation. Therefore, if you 
make a design change that causes an error during Analysis and Elaboration, you 
cannot view the netlist for the new design files, but you can still see the results from 
the last successfully compiled version of the design files. If you receive an error 
during compilation and you have not yet successfully run the appropriate 
compilation stage for your project, the viewer cannot be displayed; in this case, the 
Quartus II software issues an error message when you try to open the viewer.

Figure 13–1. Quartus II Design Flow Including the RTL Viewer and Technology Map Viewer
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RTL Viewer Overview
1 If the viewer window is open when you start a new compilation, the viewer closes 
automatically. You must open the viewer again to view the new design netlist after 
compilation completes successfully.

RTL Viewer Overview
The Quartus II RTL Viewer allows you to view a register transfer level (RTL) 
graphical representation of your Quartus II integrated synthesis results or your 
third-party netlist file within the Quartus II software.

You can view results after Analysis and Elaboration when your design uses any 
supported Quartus II design entry method, including Verilog HDL Design Files (.v), 
SystemVerilog Design Files (.sv), VHDL Design Files (.vhd), AHDL Text Design Files 
(.tdf), schematic Block Design Files (.bdf), or schematic Graphic Design Files (.gdf) 
imported from the MAX+PLUS® II software. You can also view the hierarchy of atom 
primitives (such as device logic cells and I/O ports) when your design uses a 
synthesis tool to generate a Verilog Quartus Mapping File (.vqm) or Electronic Design 
Interchange Format (.edf) netlist file. Refer to Figure 13–1 for a flow diagram.

The Quartus II RTL Viewer displays a schematic view of the design netlist after 
Analysis and Elaboration or netlist extraction is performed by the Quartus II software, 
but before technology mapping and any synthesis or fitter optimization algorithms 
occur. This view is not the final design structure because optimizations have not yet 
occurred. This view most closely represents your original source design. If you 
synthesized your design using the Quartus II integrated synthesis, this view shows 
how the Quartus II software interpreted your design files. If you are using a 
third-party synthesis tool, this view shows the netlist written by your synthesis tool.

When displaying your design, the RTL Viewer optimizes the netlist to maximize 
readability in the following ways:

■ Logic with no fan-out (its outputs are unconnected) and logic with no fan-in (its 
inputs are unconnected) are removed from the display.

■ Default connections such as VCC and GND are not shown. 

■ Pins, nets, wires, module ports, and certain logic are grouped into buses where 
appropriate.

■ Constant bus connections are grouped.

■ Values are displayed in hexadecimal format. 

■ NOT gates are converted to bubble inversion symbols in the schematic.

■ Chains of equivalent combinational gates are merged into a single gate. For 
example, a 2-input AND gate feeding a 2-input AND gate is converted to a single 
3-input AND gate.

■ State machine logic is converted into a state diagram, state transition table, and 
state encoding table, which are displayed in the State Machine Viewer.

To run the RTL Viewer for a Quartus II project, first analyze the design to generate an 
RTL netlist. To analyze the design and generate an RTL netlist, on the Processing 
menu, point to Start and click Start Analysis & Elaboration. You can also perform a 
full compilation on any process that includes the initial Analysis and Elaboration 
stage of the Quartus II compilation flow.
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State Machine Viewer Overview
To run the RTL Viewer, on the Tools menu, point to Netlist Viewers and click RTL 
Viewer. 

You can set the RTL Viewer preprocessing to run during a full compilation, which 
allows you to launch the RTL Viewer after Analysis and Synthesis has completed, but 
while the Fitter is still running. In this case, you do not have to wait for the Fitter to 
finish before viewing the schematic. This technique is useful for a large design that 
requires a substantial amount of time in the place-and-route stage.

To set the RTL Viewer preprocessing to run during compilation, on the Assignments 
menu, click Settings. In the Category list, select Compilation Process Settings and 
turn on Run RTL Viewer preprocessing during compilation. By default, this option 
is turned off.

State Machine Viewer Overview
The State Machine Viewer presents a high-level view of finite state machines in your 
design. The State Machine Viewer provides a graphical representation of the states 
and their related transitions, as well as a state transition table that displays the 
condition equation for each of the state transitions, and encoding information for each 
state.

To run the State Machine Viewer, on the Tools menu, point to Netlist Viewers and 
click State Machine Viewer. To open the State Machine Viewer for a particular state 
machine, double-click the state machine instance in the RTL Viewer or right-click the 
state machine instance and click Hierarchy Down.

Technology Map Viewer Overview
The Quartus II Technology Map Viewer provides a technology-specific, graphical 
representation of your design after Analysis and Synthesis or after the Fitter has 
mapped your design into the target device. The Technology Map Viewer shows the 
hierarchy of atom primitives (such as device logic cells and I/O ports) in your design. 
For supported families, you can also view internal registers and look-up tables (LUTs) 
inside logic cells (LCELLs) and registers in I/O atom primitives. Refer to “Viewing 
Contents of Atom Primitives” on page 13–19 for details.

1 Where possible, the port names of each hierarchy are maintained throughout 
synthesis. However, port names might change or be removed from the design. For 
example, if a port is unconnected or driven by GND or VCC, it is removed during 
synthesis. When a port name is changed, the port is assigned a related user logic name 
in the design or a generic port name such as IN1 or OUT1.

You can view your Quartus II technology-mapped results after synthesis, fitting, or 
timing analysis. To run the Technology Map Viewer for a Quartus II project, on the 
Processing menu, point to Start and click Start Analysis & Synthesis to synthesize 
and map the design to the target technology. At this stage, the Technology Map 
Viewer shows the same post-mapping netlist as does the Technology Map Viewer 
(Post-Mapping). You can also perform a full compilation, or any process that includes 
the synthesis stage in the compilation flow.
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If you have completed the Fitter stage, the Technology Map Viewer shows the 
changes made to your netlist by the Fitter, such as physical synthesis optimizations, 
while the Technology Map Viewer (Post-Mapping) shows the post-mapping netlist. If 
you have completed the Timing Analysis stage, you can locate timing paths from the 
Timing Analyzer report in the Technology Map Viewer (refer to “Viewing a Timing 
Path” on page 13–38 for details). Refer to Figure 13–1 on page 13–3 for a flow 
diagram.

To run the Technology Map Viewer, on the Tools menu, point to Netlist Viewers and 
click Technology Map Viewer, or select Technology Map Viewer from the 
Applications toolbar.

To run the Technology Map Viewer (Post-Mapping), on the Tools menu, point to 
Netlist Viewers and click Technology Map Viewer (Post-Mapping).

Introduction to the User Interface
The RTL Viewer window and Technology Map Viewer window each consist of two 
main parts: the schematic view and the hierarchy list. Figure 13–2 shows the RTL 
Viewer window and indicates these two parts. Both viewers also contain a toolbar 
that provides tools to use in the schematic view. In the Quartus II software version 9.0, 
the toolbar contains a Hierarchy List button. This tool enables you to refine your 
searches. For more information, refer to “Find Command” on page 13–44.

You can have only one RTL Viewer, one Technology Map Viewer, one Technology 
Map Viewer (Post-Mapping), and one State Machine Viewer window open at the 
same time, although each window can show multiple pages. For example, you cannot 
have two RTL Viewer windows open at the same time. The viewer window has 
characteristics similar to other “child” windows in the Quartus II software; it can be 
resized and moved, minimized or maximized, tiled or cascaded, and moved in front 
of or behind other windows.

You can detach the window and move it outside the Quartus II main interface. To 
detach a window, click the Detach Window icon on the toolbar, or, on the Window 
menu, click Detach Window. To attach the detached window back to the Quartus II 
main interface, click the Attach Window icon on the toolbar, or, on the Window menu, 
click Attach Window.
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Schematic View
The schematic view is shown on the right side of the RTL Viewer and Technology 
Map Viewer. It contains a schematic representing the design logic in the netlist. This 
view is the main screen for viewing your gate-level netlist in the RTL Viewer and your 
technology-mapped netlist in the Technology Map Viewer.

Schematic Symbols
The symbols for nodes in the schematic represent elements of your design netlist. 
These elements include input and output ports, registers, logic gates, Altera® 
primitives, high-level operators, and hierarchical instances.

Figure 13–3 shows an example of an RTL Viewer schematic for a 3-bit synchronous 
loadable counter. Example 13–1 shows the Verilog HDL code that produced this 
schematic. This example includes multiplexers and a group of registers (Table 13–1) in 
a bus along with an ADDER operator (Table 13–3 on page 13–12) inferred by the 
counting function in the HDL code.

The schematic in Figure 13–3 displays wire connections between nodes with a thin 
black line and bus connections with a thick black line.

Figure 13–2. RTL Viewer Window and RTL Toolbar
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Figure 13–4 shows a portion of the corresponding Technology Map Viewer schematic 
with a compiled design that targets a Stratix® device. In this schematic, you can see the 
LCELL (logic cell) device-specific primitives that represent the counter function, 
labeled with their post-synthesis node names. The REGOUT port represents the output 
of the register in the LCELL; the COMBOUT port represents the output of the 
combinational logic in the LUT of the LCELL. The hexadecimal number in 
parentheses below each LCELL primitive represents the LUT mask, which is a 
hexadecimal representation of the logic function of the LCELL.

Figure 13–3. Example Schematic Diagram in the RTL Viewer

Example 13–1. Code Sample for Counter Schematic Shown in Figure 13–3

module counter (input [2:0] data, input clk, input load, output [2:0] 
result);

reg [2:0] result_reg;
always @ (posedge clk)

if (load)
result_reg <= data;

else
result_reg <= result_reg + 1;

assign result = result_reg;
endmodule
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Table 13–1 lists and describes the primitives and basic symbols that you can display in 
the schematic view of the RTL Viewer and Technology Map Viewer. Table 13–3 on 
page 13–12 lists and describes the additional higher-level operator symbols used in 
the RTL Viewer schematic view.

1 The logic gates and operator primitives appear only in the RTL Viewer. Logic in the 
Technology Map Viewer is represented by atom primitives, such as registers and 
LCELLs.

Figure 13–4. Example Schematic Diagram in the Technology Map Viewer

Table 13–1. Symbols in the Schematic View (Part 1 of 3)

Symbol Description

I/O Ports An input, output, or bidirectional port in the current level of hierarchy. A device input, output, or 
bidirectional pin when viewing the top-level hierarchy. The symbol can also represent a bus. 
Only one wire is shown connected to the bidirectional symbol, representing both the input and 
output paths.

Input symbols appear on the left-most side of the schematic. Output and bidirectional symbols 
appear on the right-most side of the schematic.

I/O Connectors An input or output connector, representing a net that comes from another page of the same 
hierarchy (refer to “Partitioning the Schematic into Pages” on page 13–26). To go to the page 
that contains the source or the destination, right-click on the net and choose the page from the 
menu (refer to “Following Nets Across Schematic Pages” on page 13–27).

Hierarchy Port Connector A connector representing a port relationship between two different hierarchies. A connector 
indicates that a path passes through a port connector in a different level of hierarchy.

OR, AND, XOR Gates An OR, AND, or XOR gate primitive (the number of ports can vary). A small circle (bubble 
symbol) on an input or output port indicates the port is inverted.
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MUX A multiplexer (MUX) primitive with a selector port that selects between port 0 and port 1. A 
MUX with more than two inputs is displayed as an operator (refer to “Operator Symbols in the 
RTL Viewer Schematic View” on page 13–12).

BUFFER A buffer primitive. The figure shows the tri-state buffer, with an inverted output enable port. 
Other buffers without an enable port include LCELL, SOFT, CARRY, and GLOBAL. The NOT gate 
and EXP expander buffers use this symbol without an enable port and with an inverted output 
port.

CARRY_SUM A CARRY_SUM buffer primitive with the following ports:

■ SI – SUM IN

■ SO – SUM OUT

■ CI – CARRY IN

■ CO – CARRY OUT

LATCH A latch primitive with the following ports: 

■ D – data input

■ ENA – enable input

■ Q – data output

■ PRE – preset

■ CLR – clear

DFFE/DFFEA/DFFAE

S

A DFFE (data flipflop with enable) primitive, with the same ports as a latch and a clock trigger. 
The other flipflop primitives are similar: 

■ DFFEA (data flipflop with enable and asynchronous load) primitive with additional ALOAD 
asynchronous load and ADATA data signals

■ DFFEAS (data flipflop with enable and both synchronous and asynchronous load), which has 
ASDATA as the secondary data port

Atom Primitive Primitives are low-level nodes that cannot be expanded to any lower hierarchy. The symbol 
displays the port names, the primitive type, and its name. The blue shading indicates an atom 
primitive in the Technology Map Viewer that allows you to view the internal details of the 
primitive. Refer to “Viewing Contents of Atom Primitives” on page 13–19 for details.

Other Primitive Any primitive that does not fall into the categories above. Primitives are low-level nodes that 
cannot be expanded to any lower hierarchy. The symbol displays the port names, the primitive 
or operator type, and its name.

The figure shows an LCELL WYSIWYG primitive, with DATAA to DATAD and COMBOUT port 
connections. This type of LCELL primitive is found in the Technology Map Viewer for 
technology-specific atom primitives when the contents of the atom primitive cannot be viewed. 
The RTL Viewer contains similar primitives if the source design is a VQM or EDIF netlist.

Table 13–1. Symbols in the Schematic View (Part 2 of 3)

Symbol Description
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Instance An instance in the design that does not correspond to a primitive or operator (generally a 
user-defined hierarchy block), indicated by the double outline and green shading. The symbol 
displays the instance name. 

To open the schematic for the lower-level hierarchy, right-click and choose the appropriate 
command (refer to “Traversing and Viewing the Design Hierarchy” on page 13–18).

Encrypted Instance A user-defined encrypted instance in the design, indicated by the double outline and gray 
shading. The symbol displays the instance name. You cannot open the schematic for the lower 
level hierarchy, because the source design is encrypted.

State Machine Instance A finite state machine instance in the design, indicated by the double outline and yellow 
shading. Double-clicking this instance opens the State Machine Viewer. Refer to “State Machine 
Viewer” on page 13–16 for more details.

RAM A synchronous memory instance with registered inputs and optionally registered outputs, 
indicated by purple shading. The symbol shows the device family and the type of TriMatrix 
memory block. This figure shows a true dual-port memory block in a Stratix M-RAM block.

Logic Cloud A logic cloud is a group of combinational logic, indicated by a cloud symbol. Refer to “Grouping 
Combinational Logic into Logic Clouds” on page 13–22 for more details.

Constant A constant signal value that is highlighted in gray and displayed in hexadecimal format by 
default throughout the schematic. To change the format, refer to “Changing the Constant Signal 
Value Formatting” on page 13–24.

Table 13–1. Symbols in the Schematic View (Part 3 of 3)

Symbol Description
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Table 13–2 lists and describes the symbol used only in the State Machine Viewer.

Table 13–3 lists and describes the additional higher level operator symbols used in the 
RTL Viewer schematic view.

Table 13–2.  Symbol Available Only in the State Machine Viewer

Symbol Description

State Node The node representing a state in a finite state machine. State transitions are 
indicated with arcs between state nodes. The double circle border indicates the 
state connects to logic outside the state machine, while a single circle border 
indicates the state node does not feed outside logic.

Table 13–3. Operator Symbols in the RTL Viewer Schematic View (Part 1 of 2)

Symbol Description

An adder operator:

OUT = A + B

A multiplier operator:

OUT = A ¥ B

A divider operator:

OUT = A / B

Equals

A left shift operator:

OUT = (A << COUNT)

A right shift operator:

OUT = (A >> COUNT)
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Selecting an Item in the Schematic View
To select an item in the schematic view, ensure that the Selection Tool is enabled in the 
viewer toolbar (this tool is enabled by default). Click on an item in the schematic view 
to highlight it in red.

Select multiple items by pressing the Shift or Ctrl key while selecting with your 
mouse. You can also select all nodes in a region by selecting a rectangular box area 
with your mouse cursor when the Selection Tool is enabled. To select nodes in a box, 
move your mouse to one corner of the area you want to select, click the mouse button, 
and drag the mouse to the opposite corner of the box, then release the mouse button. 
By default, creating a box like this highlights and selects all nodes in the selected area 
(instances, primitives, and pins), but not the nets. The Viewer Options dialog box 
provides an option to select nets. To include nets, right-click in the schematic and click 
Viewer Options. In the Net Selection section, turn on the Select entire net when 
segment is selected option.

Items selected in the schematic view are automatically selected in the hierarchy list 
(refer to the “Hierarchy List” on page 13–14). The list expands automatically if 
required to show the selected entry. However, the list does not collapse automatically 
when entries are not being used or are deselected.

A modulo operator:

OUT = (A % B)

A less than comparator:

OUT = (A < B : A > B)

A multiplexer:

OUT = DATA [SEL]

The data range size is 2sel range size

A selector:

A multiplexer with one-hot select input and more than two input signals

A binary number decoder:

OUT = (binary_number (IN) == x)

for x = 0 to x = 2(n+1) - 1

Table 13–3. Operator Symbols in the RTL Viewer Schematic View (Part 2 of 2)

Symbol Description
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When you select a hierarchy box, node, or port in the schematic view, the item is 
highlighted in red but none of the connecting nets are highlighted. When you select a 
net (wire or bus) in the schematic view, all connected nets are highlighted in red. The 
selected nets are highlighted across all hierarchy levels and pages. Net selection can 
be useful when navigating a netlist because you see the net highlighted when you 
traverse between hierarchy levels or pages.

In some cases, when you select a net that connects to nets in other levels of the 
hierarchy, these connected nets also are highlighted in the current hierarchy. If you 
prefer that these nets not be highlighted, use the Viewer Options dialog box option to 
highlight a net only if the net is in the current hierarchy. Right-click in the schematic 
and click Viewer Options. In the Net Selection section, turn on the Limit selections 
to current hierarchy option.

Moving and Panning in the Schematic View
When the schematic view page is larger than the portion currently displayed, you can 
use the scroll bars at the bottom and right side of the schematic view to see other areas 
of the page.

You can also use the Hand Tool to “grab” the schematic page and drag it in any 
direction. Enable the Hand Tool with the toolbar button. Click and drag to move 
around the schematic view without using the scroll bars.

In addition to the scroll bars and Hand Tool, you can use the middle-mouse/wheel 
button to move and pan in the schematic view. Click the middle-mouse/wheel button 
once to enable the feature. Move the mouse or scroll the wheel to move around the 
schematic view. Click the middle-mouse/wheel button again to turn the feature off.

Hierarchy List
The hierarchy list is displayed on the left side of the viewer window. The hierarchy list 
displays the entire netlist in a tree format based on the hierarchical levels of the 
design. Within each level, similar elements are grouped into sub-categories. Using the 
hierarchy list, traverse through the design hierarchy to view the logic schematic for 
each level. You can also select an element in the hierarchy list to be highlighted in the 
schematic view.

1 Nodes inside atom primitives are not listed in the hierarchy list.

For each module in the design hierarchy, the hierarchy list displays the applicable 
elements listed in Table 13–4. Click the “+” icon to expand an element.

Table 13–4. Hierarchy List Elements (Part 1 of 2)

Elements Description

Instances Modules or instances in the design that can be expanded to lower hierarchy levels.

State Machines State machine instances in the design that can be viewed in the State Machine Viewer.
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Selecting an Item in the Hierarchy List
When you click any item in the hierarchy list, the viewer performs the following 
actions:

■ Searches for the item in the currently viewed pages and displays the page 
containing the selected item in the schematic view if it is not currently displayed. 
(If you are currently viewing a filtered netlist, for example, the relevant page 
within the filtered netlist is displayed.)

■ If the selected item is not found in the currently viewed pages, the entire design 
netlist is searched and the item is displayed in a default view.

■ Highlights the selected item in red in the schematic view.

When you double-click an instance in the hierarchy list, the viewer displays the 
underlying implementation of the instance.

You can select multiple items by pressing the Shift or Ctrl key while selecting with 
your mouse. When you right-click an item in the hierarchy list, you can navigate in 
the schematic view using the Filter and Locate commands. Refer to “Filtering in the 
Schematic View” on page 13–29 and “Probing to Source Design File and Other 
Quartus II Windows” on page 13–35 for more information.

Enable or Disable the Auto Hierarchy List
When you select any node or net in a schematic, the hierarchy list is expanded 
automatically to show the selected node or net in the list. This allows you to easily 
identify the node or net when you have a complex schematic. By default, this option is 
disabled.

To enable the auto hierarchy list option, perform the following steps:

1. On the Tools menu, click Options.

2. In the Options dialog box, click Netlist Viewers under Category.

Primitives Low-level nodes that cannot be expanded to any lower hierarchy level. These include:

■ Registers and gates that you can view in the RTL Viewer when using Quartus II integrated synthesis

■ Logic cell atoms in the Technology Map Viewer or in the RTL Viewer when using a VQM or EDIF from 
third-party synthesis software

In the Technology Map Viewer, you can view the internal implementation of certain atom primitives, but 
you cannot traverse into a lower level of hierarchy.

Pins The I/O ports in the current level of hierarchy.

■ Pins are device I/O pins when viewing the top hierarchy level and are I/O ports of the design when 
viewing the lower levels.

■ When a pin represents a bus or an array of pins, expand the pin entry in the list view to see individual 
pin names. 

Nets Nets or wires connecting the nodes. When a net represents a bus or array of nets, expand the net entry in 
the tree to see individual net names.

Logic Clouds A group of related combinational logics of a particular source. You can automatically or manually group 
combinational logics or ungroup logic clouds in your design.

Table 13–4. Hierarchy List Elements (Part 2 of 2)

Elements Description
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3. Turn on the Enable Auto Hierarchy Expansion option.

4. Click OK.

State Machine Viewer
The State Machine Viewer displays a graphical representation of the state machines in 
your design. You can open the State Machine Viewer in any of the following ways:

■ On the Tools menu, point to Netlist Viewers and click State Machine Viewer

■ Double-click on a state machine instance in the RTL Viewer

■ Right-click on a state machine instance in the RTL Viewer and click Hierarchy 
Down

■ Select a state machine instance in the RTL Viewer, and on the Project menu, point 
to Hierarchy and click Down

Figure 13–5 shows an example of the State Machine Viewer for a simple state 
machine. The State Machine toolbar on the left side of the viewer provides tools you 
can use in the state diagram view.

State Diagram View
The state diagram view is shown at the top of the State Machine Viewer window. It 
contains a diagram of the states and state transitions.

Figure 13–5. State Machine in the State Machine Viewer
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The nodes that represent each state are arranged horizontally in the state diagram 
view with the initial state (the state node that receives the reset signal) in the left-most 
position. Nodes that connect to logic outside of the state machine instance are 
represented by a double circle. The state transition is represented by an arc with an 
arrow pointing in the direction of the transition.

When you select a node in the state diagram view, if you turn on the Highlight Fan-in 
or Highlight Fan-out command from the View menu or the State Machine Viewer 
toolbar, the respective fan-in or fan-out transitions from the node are highlighted in 
red.

1 An encrypted block with a state machine displays encoding information in the state 
encoding table, but does not display a state transition diagram or table.

State Transition Table
The state transition table on the Transitions tab at the bottom of the State Machine 
Viewer window displays the condition equation for each state transition. Each 
transition (each arc in the state diagram view) is represented by a row in the table. The 
table has the following three columns:

■ Source State—the name of the source state for the transition

■ Destination State—the name of the destination state for the transition

■ Condition—the condition equation that causes the transition from source state to 
destination state

To see all of the transitions to and from each state name, click the appropriate column 
heading to sort on that column.

The text in each column is left-aligned by default; to change the alignment and more 
easily see the relevant part of the text, right-click in the column and click Align Right. 
To change back to left alignment, click Align Left.

Click in any cell in the table to select it. To select all cells, right-click in the cell and 
click Select All; or, on the Edit menu, click Select All. To copy selected cells to the 
clipboard, right-click the cells and click Copy Table; or, on the Edit menu, point to 
Copy and click Copy Table. You can paste the table into any text editor as 
tab-separated columns.

State Encoding Table
The state encoding table on the Encoding tab at the bottom of the State Machine 
Viewer window displays encoding information for each state transition.

To view state encoding information in the State Machine Viewer, you must have 
synthesized your design using Start Analysis & Synthesis. If you have only elaborated 
your design using Start Analysis & Elaboration, the encoding information is not 
displayed.

Selecting an Item in the State Machine Viewer
You can select and highlight each state node and transition in the State Machine 
Viewer. To select a state transition, click the arc that represents the transition.
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When you select a state node, transition arc, or both in the state diagram view, the 
matching state node and equation conditions in the state transition table are 
highlighted. Conversely, when you select a state node, equation condition, or both in 
the state transition table, the corresponding state node and transition arc are 
highlighted in the state diagram view.

Switching Between State Machines
A design may contain multiple state machines. To choose which state machine to 
view, use the State Machine selection box located at the top of the State Machine 
Viewer. Click in the drop-down box and select the desired state machine.

Navigating the Schematic View
The previous sections provided an overview of the user interface for each netlist 
viewer, and how to select an item in each viewer. This section describes methods to 
navigate through the pages and hierarchy levels in the schematic view of the RTL 
Viewer and Technology Map Viewer.

Traversing and Viewing the Design Hierarchy
You can open different hierarchy levels in the schematic view using the hierarchy list 
(refer to “Hierarchy List” on page 13–14), or the Hierarchy Up and Hierarchy Down 
commands (right-click menu) in the schematic view.

Use the Hierarchy Down command to go down into, or expand an instance’s 
hierarchy, and open a lower level schematic showing the internal logic of the instance. 
Use the Hierarchy Up command to go up in hierarchy, or collapse a lower level 
hierarchy, and open the parent higher level hierarchy. When the Selection Tool is 
selected, the appropriate option is available when your mouse pointer is located over 
an area of the schematic view that has a corresponding lower or higher level 
hierarchy.

The mouse pointer changes as it moves over different areas of the schematic to 
indicate whether you can move up, down, or both up and down in the hierarchy 
(Figure 13–6). To open the next hierarchy level, right-click in that area of the schematic 
and click Hierarchy Down or Hierarchy Up, as appropriate, or double-click in that 
area of the schematic.

Flattening the Design Hierarchy
You can flatten the design hierarchy to view the design without hierarchical 
boundaries. To flatten the hierarchy from the current level and all the lower level 
hierarchies of the current design hierarchy, right-click in the schematic and click 
Flatten Netlist. To flatten the entire design, choose Flatten Netlist from the top-level 
schematic of the design.

Figure 13–6. Mouse Pointers Indicate How to Traverse Hierarchy
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Viewing the Contents of a Design Hierarchy within the Current Schematic
You can use the Display Content and Hide Content (right-click menu) commands to 
show or hide a lower hierarchy level for a specific instance within the schematic for 
the current hierarchy level.

To display the lower hierarchy netlist of an instance on the same schematic as the 
remaining logic in the currently viewed netlist, right-click the selected instance and 
click Display Content.

To hide all of the lower hierarchy logic of a hierarchy box into a closed instance, 
right-click the selected instance and click Hide Content.

Viewing Contents of Atom Primitives
In the Technology Map Viewer, you can view the contents of certain device atom 
primitives to see their underlying implementation details. For logic cell (LCELL) 
atoms in the Stratix and Cyclone® series of devices, in Arria® GX devices, and in 
MAX® II devices, you can view LUTs, registers, and logic gates. For I/O atoms in the 
Stratix and Cyclone series of devices, in Arria GX devices, and HardCopy® II devices, 
you can view registers and logic gates.

In addition, you can view the implementation of RAM and DSP blocks in certain 
devices in the RTL Viewer or Technology Map Viewer. You can view the 
implementation of RAM blocks in the Stratix and Cyclone series of devices, and in 
Arria GX devices. You can view the implementation of DSP blocks only in the Stratix 
series of devices and Arria GX devices.

If you can view the contents of an atom instance, it is blue in the schematic view 
(Figure 13–7).

To view the contents of one or more atom primitive instances, select the desired atom 
instances. Right-click a selected instance and click Display Content. You can also 
double-click on the desired atom instance to view the contents. Figure 13–8 shows an 
expanded version of the instance in Figure 13–7.

Figure 13–7. Instance That Can Be Expanded to View Internal Contents
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To hide the contents (and revert to the compact format), select and right-click the atom 
instance(s), and click Hide Content.

1 In the schematic view, the internal details within an atom instance cannot be selected 
as individual nodes. Any mouse action on any of the internal details is treated as a 
mouse action on the atom instance.

Viewing the Properties of Instances and Primitives
You can view the properties of an instance or primitive using the Properties dialog 
box. To view the properties of an instance or a primitive in the RTL Viewer or 
Technology Map Viewer, right-click the node and click Properties.

The Properties dialog box contains the following information about the selected node:

■ The parameter values of an instance.

■ The active level of the port (for example, active high or active low). An active low 
port is denoted with an exclamation mark “!”.

■ The port’s constant value (for example, VCC or GND). Table 13–5 describes the 
possible value of a port.

In the LUT of a logic cell (LCELL), the Properties dialog box contains the following 
additional information:

■ The schematic of the LCELL.

■ The Truth Table representation of the LCELL.

Figure 13–8. Internal Contents of the Atom Instance in Figure 13–7.

Table 13–5. Possible Port Values

Value Description

VCC The port is not connected and has VCC value (tied to VCC)

GND The port is not connected and has GND value (tied to GND)

-- The port is connected and has value (other than VCC or GND)

Unconnected The port is not connected and has no value (hanging)
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■ The Karnaugh map representation of the LCELL.

Viewing LUT Representations in the Technology Map Viewer
You can view different representations of an LUT by right-clicking on the selected 
LUT and selecting Properties. This feature is supported for the Stratix and Cyclone 
series of devices, Arria GX devices, and MAX II devices only. There are three tabs in 
the Properties dialog box, which you can choose from to view the LUT 
representations:

■ The Schematic tab (see Figure 13–9) shows you the equivalent gate 
representations of the LUT. 

■ The Truth Table tab (see Figure 13–10) shows the truth table representations. 

■ The Karnaugh Map tab (see Figure 13–11) shows the Karnaugh map 
representations of the LUT. The Karnaugh map supports up to 6 input LUTs. 

For details about the Ports tab, refer to “Viewing the Properties of Instances and 
Primitives”.

Figure 13–9. Schematic Tab
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